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How This Manual Is Organized
Chapter 1

Operations Required to Use the Machine
Describes the flow of operations required first, such as logging in to the machine, and connecting to a network.

Chapter 2

Setting Up the Machine for the First Time
Uses general examples to describe the setup required for starting to use the functions of the machine.

Chapter 3

Using the System Options/MEAP Applications
Describes the procedure for installing system options and MEAP applications using the Register/Update 
Software function, and the procedure for using system options and MEAP applications.

As we are constantly improving our products, if you need an exact specification, please contact Canon.
Screen shots used in this manual may differ from the ones you actually see.

•
•
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Preface
It is necessary to specify settings in advance to use some functions of the machine. Refer to “Flow of Settings for Using 
the Desired Functions” on p. 2 in this manual to check the flow of the required operations.
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Symbols Used in This Manual
The following symbols are used in this manual to explain procedures, restrictions, handling precautions, and instructions 
that should be observed for safety.

Indicates operational requirements and restrictions. Be sure to read these items carefully to 
operate the machine correctly, and avoid damage to the machine or property.

Indicates a clarification of an operation, or contains additional explanations for a procedure. 
Reading these notes is highly recommended.

Keys and Buttons Used in This Manual
The following symbols and key/button names are a few examples of how keys and buttons to be clicked or pressed are 
expressed in this manual:

- Touch Panel Display Keys: [Key Name] - Buttons on Computer Operation Screens: [Button Name]

Example: [Cancel]/[Close] Example: [OK]/[Add]

- Control Panel Keys: Key Icon (Key Name)

Example: (Start) /  (Key Name)
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These functions 
can be used by default
(no settings are required).

Copy

● The optional FAX Board is required.

● An Optional product(s) and/or license registration may be required, depending on the print function.

● The optional Fax Board is required.

● The optional Remote Fax Kit and license registration are required.

Scan and Store*1 /
 Access Stored Files*1*2

(Memory Media)

Register/Update
Software*3

Fax
(Receive on the Machine)

* These settings are only required when connecting to a network. 
 They are not required when connecting via USB.

● Remote Scan Settings

● Settings for Printing from a Computer

● MEAP Service Management Service
(SMS) Settings

● Remote UI Settings

● Using an Advanced Box on the Network

● Fax Settings

● Settings for Fax from a Computer

● Remote Fax Settings

● E-Mail/ I-Fax Settings

See e-Manual.

● Using TCP/IP:

● Using SMB/CIFS:
● Setting Up a Computer as a File Server*5

Fax
(Sending/Receiving)

Scanner

Scan and Send*4

Scan and Store / 
Access Stored

Files
(Network)

Remote UI

MEAP

Sending and Receiving Documents
via the Remote Fax Server

Sending Faxes from a Computer 
via the Machine*4

Using an Advanced Box
on the Network*1

Sending  Faxes from the Machine*4

Sending to a File Server

Sending by E-Mail/I-Fax

● Connecting to a Network

● Connecting via a USB

See e-Manual. See e-Manual.

● Using TCP/IP:

● Using SMB/CIFS:　
● Using AppleTalk:　
● Using Netware:

● Using TCP/IP:

See e-Manual.

● Using TCP/IP:

● Using SMB/CIFS:

Print*4

● Connecting to a Network

● Network Settings

*1 To print PDF files stored in memory media or the Advanced Space of another machine on the network, the PS Printer Kit or Direct Print Kit (for PDF) is required. (Both the PS 
Printer Kit and Direct Print Kit (for PDF) require license registration.) 

*2 The default setting for displaying memory media is 'Off'. To use the memory media, press [Display Settings] in [Preferences] (Settings/Registration) → press [Store Location 
Display Settings] → [Memory Media] → [On]. 

*3 To access a distribution server to register/update software, it is necessary to perform the "Connecting to a Network" and "Network Settings" operations indicated in this flowchart. 
To register/update software using the Remote UI, it is necessary to perform the "Connecting to a Network," "Network Settings," and "Remote UI Settings" operations. 

*4 For information on the system requirements, see e-Manual > Optional Products and Software. 
*5 The file servers you can use depend on your network. For details on the file servers you can use, see e-Manual > Network.

● The optional FAX Board is 
required.

● If you are using the imageRUNNER ADVANCE 
C2020, depending on the region, the Color 
Universal Send Kit and license registration may be 
required.

● If you are using the imageRUNNER ADVANCE 
C2020, depending on the region, the the Color 
Universal Send Kit or 2.5inch/80GB HDD and 
license registration may be required.

● If you are using the imageRUNNER ADVANCE 
C2020, depending on the region, the Color 
Universal Send Kit and license registration may be 
required.

Flow of Settings for Using the Desired Functions
This flowchart indicates the flow of settings required for using each function of the machine. After checking the flow of settings 
required, refer to the detailed page in this manual or the e-Manual to perform the actual setting procedure.

First, refer to “Logging In to the Machine as an Administrator,” on p. 8.

See “Connecting the Machine 
to a Network,” on p. 9.

See “Connecting the Machine 
to a Network,” on p. 9.
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These functions 
can be used by default
(no settings are required).

Copy

● The optional FAX Board is required.

● An Optional product(s) and/or license registration may be required, depending on the print function.

● The optional Fax Board is required.

● The optional Remote Fax Kit and license registration are required.

Scan and Store*1 /
 Access Stored Files*1*2

(Memory Media)

Register/Update
Software*3

Fax
(Receive on the Machine)

* These settings are only required when connecting to a network. 
 They are not required when connecting via USB.

● Remote Scan Settings

● Settings for Printing from a Computer

● MEAP Service Management Service
(SMS) Settings

● Remote UI Settings

● Using an Advanced Box on the Network

● Fax Settings

● Settings for Fax from a Computer

● Remote Fax Settings

● E-Mail/ I-Fax Settings

See e-Manual.

● Using TCP/IP:

● Using SMB/CIFS:
● Setting Up a Computer as a File Server*5

Fax
(Sending/Receiving)

Scanner

Scan and Send*4

Scan and Store / 
Access Stored

Files
(Network)

Remote UI

MEAP

Sending and Receiving Documents
via the Remote Fax Server

Sending Faxes from a Computer 
via the Machine*4

Using an Advanced Box
on the Network*1

Sending  Faxes from the Machine*4

Sending to a File Server

Sending by E-Mail/I-Fax

● Connecting to a Network

● Connecting via a USB

See e-Manual. See e-Manual.

● Using TCP/IP:

● Using SMB/CIFS:　
● Using AppleTalk:　
● Using Netware:

● Using TCP/IP:

See e-Manual.

● Using TCP/IP:

● Using SMB/CIFS:

Print*4

● Connecting to a Network

● Network Settings

*1 To print PDF files stored in memory media or the Advanced Space of another machine on the network, the PS Printer Kit or Direct Print Kit (for PDF) is required. (Both the PS 
Printer Kit and Direct Print Kit (for PDF) require license registration.) 

*2 The default setting for displaying memory media is 'Off'. To use the memory media, press [Display Settings] in [Preferences] (Settings/Registration) → press [Store Location 
Display Settings] → [Memory Media] → [On]. 

*3 To access a distribution server to register/update software, it is necessary to perform the "Connecting to a Network" and "Network Settings" operations indicated in this flowchart. 
To register/update software using the Remote UI, it is necessary to perform the "Connecting to a Network," "Network Settings," and "Remote UI Settings" operations. 

*4 For information on the system requirements, see e-Manual > Optional Products and Software. 
*5 The file servers you can use depend on your network. For details on the file servers you can use, see e-Manual > Network.

● The optional FAX Board is 
required.

● If you are using the imageRUNNER ADVANCE 
C2020, depending on the region, the Color 
Universal Send Kit and license registration may be 
required.

● If you are using the imageRUNNER ADVANCE 
C2020, depending on the region, the the Color 
Universal Send Kit or 2.5inch/80GB HDD and 
license registration may be required.

● If you are using the imageRUNNER ADVANCE 
C2020, depending on the region, the Color 
Universal Send Kit and license registration may be 
required.

See “Setting a Network on the Machine,” on p. 12.

See “Setting a Network on the Machine,” on p. 12.

See “Setting a Network on the Machine,” on p. 12.

See “Sending/Receiving Faxes via the 
Remote Fax Server,” on p. 35.

See “Sending Faxes,” on p. 29.

See “Sending Faxes from a Computer Using 
the Machine,” on p. 37.

See “Printing a Document from a Computer,” 
on p. 39.

See “Using an Advanced Box on the 
Network,” on p. 45.

See “Sending Scanned Data to a File Server,” 
on p. 24.

See “Using E-Mail/I-Fax,” on p. 20.

See “Settings Required to Use the Remote 
UI,” on p. 15.

See “Settings Required to Use SMS,” on p. 16.

See “Scanning an Original,” on p. 42.
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Logging In to the 
Machine as an 
Administrator

To specify the settings, you must log in to the 
machine as an administrator. There are two 
methods for logging in; logging in from the 
touch panel display of the machine and logging 
in from a computer using the Remote UI.

Logging In from the Touch 
Panel Display

To log in as the administrator using the touch panel display, 
enter the System Manager ID and System PIN as follows:

System Manager ID
7654321

System PIN
7654321

The default setting for both the System Manager ID and 
System PIN is '7654321'. We recommend that you change both 
the System Manager ID and System PIN after logging in to the 
machine.

In this example, the default System Manager ID and System 
PIN are used to log in.

1	 Press (Settings/Registration).

2	 Press [Log In].

	

3	 Enter the System Manager ID and System PIN → 
press [Log in].
[System Manager ID]: 7654321
[System PIN]: 7654321 (the number you enter is masked with 
asterisks)

	

You are now logged in to the machine as an administrator. 
Refer to Chapter 2, "Setting Up the Machine for the First Time," 
to specify the settings for using each function.

When you have finished specifying settings and performing 
operations, press [Log Out] or the  (Log In/Out) on the 
control panel to log out from the machine.

	

To go back to the Main Menu screen, press (Main Menu).

Logging In Using the Remote 
UI

To log in as the administrator using the Remote UI, enter the 
System Manager ID and System PIN as follows:

System Manager ID
7654321

System PIN
7654321

The default setting for both the System Manager ID and 
System PIN is '7654321'. We recommend that you change both 
the System Manager ID and System PIN after logging in to the 
machine.
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To log in as the administrator using the Remote UI, you must 
specify the network connection settings in advance. For 
instructions on specifying the network connection settings, 
see “Connecting the Machine to a Network,” on p. 9.
If you are using a login service, see e-Manual > MEAP.
If the authentication function is not set, the Log In screen is 
not displayed.
For information on necessary system environment and 
preparation to start the Remote UI, see e-Manual > Remote UI.

In this example, the default System Manager ID and System 
PIN are used to log in.

1	 Start your Web browser.

2	 Enter 'http://<IP address or host name of the 
machine>' in [Address].

3	 Enter the System Manager ID and System PIN → 
click [Administrator Login].
[System Manager ID]: 7654321
[System PIN]: 7654321

	

You are now logged in to the machine as an administrator. 
Refer to Chapter 2, "Setting Up the Machine for the First Time," 
to specify the settings for using each function. 
When you have finished specifying settings and performing 
operations, press [Log Out] to log out.

	

•

•
•

•

Connecting the Machine 
to a Network

To use functions such as the Print or Fax function 
from a computer, it is necessary to connect the 
machine to a network in advance.

Before setting the network connection, it is necessary to 
connect the machine and the computer with a network 
cable. For details, see e-Manual > Network > Connecting the 
Machine to a Computer or Network.

1	 Press (Settings/Registration).

2	 Press [Preferences].

	

3	 Press [Network].
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4	 Press [Confirm Network Connection Set. 
Changes].

	

5	 Press [On] → [OK].

	

6	 Press [Ethernet Driver Settings].

If the desired setting is not displayed, press  or  to scroll 
to the desired setting.

	

7	 Press [On] for <Auto Detect> → [OK].

	

The interface settings are now specified. 
Next, set the communication environment for the machine and 
the computers on the network.

8	 Press [SNMP Settings].

	

9	 Press [On] for <Use SNMP v. 1> → press [Set 
Community Name 1].
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10	 Specify the following settings → press [OK].
In this example, the following settings are specified:
<Community Name 1>: [On]
<MIB Access Permission>: [Read Only]
[Community Name]: public

	

11	 Press [On] for <Get Printer Mgmt Info from Host> 
→ [OK].

	

12	 Press [Dedicated Port Settings].

	

13	 Press [On] → [OK].

	

14	 Press [Use Spool Function].

	

15	 Press [On] → [OK].

	

The communication environment settings are now specified. 
Next, refer to “Setting a Network on the Machine,” on p. 12 to 
specify the settings to use the network.
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Setting a Network on 
the Machine

After connecting the machine to the network, 
you must specify the settings on your machine.
In this example, a TCP/IP type network is used.

TCP/IP Settings
[Use IPv4]: On
[IP Address Settings]: 192.168.1.21

DNS Settings
[DNS Server Address Settings]: 192.168.1.22
[Host Name]: host-name
[Domain Name]:
organization.company.com

1	 Press (Settings/Registration).

2	 Press [Preferences].

	

3	 Press [Network].

	

4	 Press [TCP/IP Settings].

	

5	 Press [IPv4 Settings].

	

6	 Press [Use IPv4].
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7	 Press [On] → [OK].

	

8	 Press [IP Address Settings].

	

9	 Specify the following settings → press [OK].
In this example, the following values are entered:
[IP Address]: 192.168.1.21
[Subnet Mask]: 255.255.255.0
[Gateway Address]: 192.1.254.0

	

The IP address settings are now specified. 
Next, specify the DNS settings.

10	 Press [DNS Settings].

	

11	 Press [DNS Server Address Settings].

	

12	 Enter the IP address in [Primary DNS Server] for 
<IPv4> → press [OK].
In this example, ‘192.168.1.22’ is entered.
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13	 Press [DNS Host/Domain Name Settings].

	

14	 Enter a host name and domain name for <IPv4> 
→ press [OK].
In this example, the following values are entered:
[Host Name]: host-name
[Domain Name]: organization.company.com

	

15	 Turn OFF the main power of the machine, and 
then turn ON the main power again.
The DNS setting becomes effective only after turning the 
machine's main power OFF, and then ON.

The DNS settings are now specified. 
Next, confirm whether the network is correctly set.

16	 Press (Start).

17	 Press [Preferences] → [Network] → [TCP/IP 
Settings].

18	 Press [IPv4 Settings].

	

19	 Press [PING Command].

	

20	 Enter an IPv4 address that exists on the network 
→ press [Start].
In this example, ‘192.168.1.1’ is entered.

	

21	 Confirm the response → press [OK].

The communication environment settings are now specified. 
Next, refer to “Managing the Machine from a Computer,” on p. 
15 to specify the settings for using the management functions 
from a computer.
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Managing the Machine 
from a Computer

This section describes the operations that the 
administrator must perform to enable the 
machine to be managed from a computer 
screen.
The Remote UI or SMS is used to manage the 
machine from a computer.

Remote UI (User Interface):
The Remote UI is software that enables you to access the 
machine's functions from your computer's Web browser. 
For example, the Remote UI enables you to access the 
machine to check job status, execute jobs, and specify 
various settings.

1.	 Settings Required to Use the Remote UI
2.	 Managing the Machine Using the Remote UI

SMS (Service Management Service):
SMS is software that enables you to access the machine’s 
functions from your computer’s Web browser to install 
and manage MEAP applications (MEAP: the application 
platform installed in Canon multitasking machines).

1.	 Settings Required to Use SMS
2.	 Managing the Machine Using SMS

To use the Remote UI and SMS, you must specify 
the settings on your machine in advance.

Settings Required to Use the 
Remote UI

If you use the Remote UI, you can access the machine using 
a Web browser to manage the machine and check its status 
from a computer. To start the Remote UI, it is necessary to 
enable it on the machine.

Remote UI
[Remote UI]: On

1	 Press (Settings/Registration).

●

●

2	 Press [Management Settings].

	

3	 Press [License/Other].

	

4	 Press [Remote UI].
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5	 Press [On] for <Remote UI> → [OK].
You can specify the desired settings for <Use SSL>.

	

6	 Press [Close].

7	 Turn OFF the main power of the machine, and 
then turn ON the main power again.

The [Remote UI] setting becomes effective only after turning 
the machine’s main power OFF, and then ON.

Managing the Machine Using 
the Remote UI

1	 Start your Web browser.

2	 Enter 'http://<IP address or host name of the 
machine>' in [Address].
The Remote UI screen is displayed.

3	 You can check job statuses, consumable levels, 
and change various settings.

	

Settings Required to Use 
SMS

If you use SMS, you can manage the MEAP applications 
installed in the machine from the Web browser on your 
computer. 
MEAP applications are software used for customizing and 
expanding the functionality of the machine.
To start SMS, it is necessary to enable your computer to 
access the machine.

TCP/IP Settings
[Use HTTP]: [On]

1	 Press (Settings/Registration).

2	 Press [Preferences].

	

3	 Press [Network].

	



17

O
pe

ra
tio

ns
 R

eq
ui

re
d 

to
 U

se
 th

e 
M

ac
hi

ne

1

4	 Press [TCP/IP Settings].

	

5	 Press [Use HTTP].

	

6	 Press [On] → [OK].

	

7	 Press [Close].

8	 Turn OFF the main power of the machine, and 
then turn ON the main power again.
The [Use HTTP] setting becomes effective only after turning 
the machine’s main power OFF, and then ON.

Managing the Machine Using 
SMS

1	 Start your Web browser.

2	 Enter 'http://<the IP address or host name of the 
machine>' in [Address].

3	 Enter the System Manager ID and System PIN → 
click [Administrator Login].
[System Manager ID]: 7654321
[System PIN]: 7654321

	

You are now logged in to the Remote UI.

4	 Click [Service Management Service].

	

The [Login] page of SMS is displayed.
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5	 Enter the password → press [Log In].
In this example, ‘MeapSmsLogin’ is entered.

	

The default password is ‘MeapSmsLogin’ (case sensitive). We 
recommend that you change the password after logging in to 
SMS.

The SMS screen appears.

6	 Perform MEAP application management by 
confirming and installing the MEAP applications.
For information on each operation, see the e-Manual.
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Using E-Mail/I-Fax
You can send originals scanned on the machine 
using e-mail or internet fax (I-fax).
This example describes the procedure for 
sending a design proposal in PDF format.
The flow of operations is indicated below.

1.	Settings Required to Send E-Mail/I-Faxes
Specifying E-Mail/I-Fax Settings

2.	Sending E-Mail/I-Faxes
Storing New Destinations
Sending an E-Mail Message

Settings for receiving e-mail/I-faxes must also be specified. 
For information on the settings, see e-Manual > Settings/
Registration > Common Communication Settings for E-Mail/I-
Fax.

Settings Required to Send E-
Mail/I-Faxes

Communication settings must be specified to send e-mail/I-
faxes.
The following example describes the procedure for the 
settings below:

	

<Communication Settings: Basic Settings>
[E-Mail Address]: john@example.com
[SMTP Server]: 192.168.1.2

<Communication Settings: Authentication 
Settings>

<SMTP Authentication (SMTP AUTH)>: On
[User Name]: user_name*1

[Password]: password*1

To specify the communication server settings, you must log in as an 
administrator. To log in as an administrator, see “Logging In to the 
Machine as an Administrator,” on p. 8.

*1 The user name and password for logging in to the SMTP server.

	

Specifying E-Mail/I-Fax Settings

1	 Press (Settings/Registration).

•

•
•

2	 Press [Function Settings].

	

3	 Press [Send].

	

4	 Press [E-Mail/I-Fax Settings].

	

5	 Press [Communication Settings].
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6	 Specify the following settings → press [Next].
In this example, the following values are entered:
[E-Mail Address]: john@example.com
[SMTP Server]: 192.168.1.2

	

You can specify the desired settings for <Use POP RX> and 
<Use SMTP RX>. For information on the settings, see e-Manual 
> Settings/Registration > Common Communication Settings 
for E-Mail/I-Fax.

7	 If the [Communication Settings: POP Server 
Settings] screen is displayed, press [Next].
The [Communication Settings: POP Server Settings] screen is 
displayed if you set <Use POP RX> on the [Communication 
Settings: Basic Settings] screen to 'On'.

	

8	 Specify the <SMTP TX> settings → press [Next].

	

You can specify the desired settings for <SMTP RX>. To 
encrypt data to be sent using SSL, set <SMTP TX> to 'On'.

Even if you select [On] for <SMTP TX>, the data will not be 
encrypted if the SMTP host does not support encryption.

•

•

9	 Specify the following settings → press [OK].
In this example, the following settings are specified:
<SMTP Authentication (SMTP AUTH)>: On
[User Name]: user_name
[Password]: password

	

The settings for sending e-mail/I-faxes are now set.

Sending E-Mail/I-Faxes
Register e-mail/I-fax destinations in the Address Book before 
sending e-mail.

Storing New Destinations

When sending a scanned original using e-mail, register the 
information for the destination.
In this example, the e-mail address for the planning 
department is registered as the destination.

1	 Press [Scan and Send].
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2	 Press [Address Book].

	

3	 Press [Other Ops.].

	

4	 Press [Register/Edit].

	

5	 Press [Register New Dest.].

	

6	 Press [E-Mail].

	

7	 Enter the new name → press [Next]. 
In this example, ‘planning dept.’ is entered.
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8	 Enter the e-mail address → press [OK]. 
In this example, ‘mike@example.com’ is entered.

	

9	 Press [Close].

10	 Press [OK].

Sending an E-Mail Message

The scanned data is sent to a destination registered in 
“Storing New Destinations,” on p. 21 as an e-mail attachment.

1	 Place your originals.

2	 Press [Address Book].

	

3	 Select [planning dept.] → press [OK].

	

4	 Change the settings as necessary.

	

5	 Press (Start).
If the [Set SMTP Authentication] screen is displayed, enter the 
user name and password → press [OK].
If the [Original Size] screen is displayed, specify the size of the 
original → press [OK].

6	 Press [Start Sending].

	

The data is attached to the e-mail and sent.
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Sending Scanned Data 
to a File Server

This example describes the procedure for 
scanning an original and sending it to a file server 
(computer) in PDF format.

1.	Settings Required to Send Data to a 
Computer

Setting a Computer

2.	Scanning and Sending an Original to the 
Shared Folder of a Computer

Storing New Destinations
Sending Scanned Data to a Shared Folder

Settings Required to Send 
Data to a Computer

To send data to a computer, you must specify settings for 
the shared folder.
The following example describes the procedure for the 
settings below:

	

Computer Settings

TCP/IP Settings
Enable NetBIOS over TCP/IP

Adding users
[User Name]: user_name
[Password]: password

Creating a shared folder
[Share Name]: share
[Permissions]: Full Control

	

Setting a Computer

Data scanned with the machine can be saved to a shared 
folder. The shared folder can be set from your computer.
The following example describes the procedure for setting a 
shared folder with Windows Vista:

1	 Log on to Windows with administrator privileges.

2	 Click (Start) → right-click [Computer].

•

•
•

●

3	 Click [Properties] → check the computer name.

	

4	 From the [Start] menu, right-click [Network] → 
select [Properties].

	

5	 Click [View Status] for [Local Area Connection].
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6	 Click [Properties]. 

	

7	 Select the following items.

[Client for Microsoft Networks]

[File and Printer Sharing for Microsoft Networks]

[Internet Protocol Version 4 (TCP/IPv4)]

	

•

•

•

8	 Select [Internet Protocol Version 4 (TCP/IPv4)] → 
click [Properties].

	

9	 Click [Advanced] on the [General] tab.
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10	 Click the [WINS] tab.

	

11	 Select [Enable NetBIOS over TCP/IP] → click [OK].

	

12	 Restart the computer.

The network settings are now specified. 
Next, create a user for accessing the shared folder from the 
machine.

13	 From the [Start] menu, right-click [Computer] → 
select [Manage].

	

14	 Click [Local Users and Groups] in [System Tools] → 
right-click the [Users] folder → select [New User] 
from the pop-up menu.

	

15	 Specify the following settings → click [Create] → 
[Close].
In this example, the following values are entered:
[User Name]: user_name
[Password]: password
[Confirm password]: password
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The user is now created. 
Next, create a folder for sending data from the machine.

16	 Create the folder to save the data to in a location 
of your choice.
In this example, a folder named ‘share’ is created.

	

17	 Right-click the folder → select [Share] from the 
menu that appears.

	

18	 Select the user to perform sharing with → click 
[Add] → [Share].

	

19	 Click [Done].
The setting of the computer are now specified.

Scanning and Sending an 
Original to the Shared Folder 
of a Computer

You can send data scanned with the machine to the shared 
folder.

Storing New Destinations

Register the information for the shared folder created in 
“Setting a Computer,” on p. 24 to the Address Book of the 
machine.

1	 Press [Scan and Send].

	

2	 Press [Address Book].

	

3	 Press [Other Ops.].
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4	 Press [Register/Edit].

	

5	 Press [Register New Dest.].

	

6	 Press [File].

	

7	 Enter the new name → press [Next].
In this example, ‘Original’ is entered.

	

8	 Specify the following settings → press [OK].
[Protocol]: Windows(SMB)
[Host Name]: \\user-1\share
[User Name]: user_name
[Password]: password

For [Host Name], enter ‘\\<name of your computer>\<name 
of the shared folder>’.

For [Folder Path], enter ‘\\<name of a folder inside the 
shared folder>’. This can be omitted as necessary.

	

9	 Press [Close].

10	 Press [OK].

Sending Scanned Data to a Shared Folder

Send a scanned original to the shared folder registered in 
“Storing New Destinations,” on p. 27.

1	 Place your originals.

•

•
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2	 Press [Address Book].

i	

3	 Select 'Original' → press [OK].

	

4	 Change the settings as necessary.

	

5	 Press (Start).
If the [Original Size] screen is displayed, specify the size of the 
original → press [OK].

6	 Press [Start Sending].

	

The scanned original is sent to the shared folder.

Sending Faxes
This example describes the procedure for 
sending a fax.
The flow of operations is indicated below.

1.	Settings Required to Send Faxes
Registering the Fax Number, Unit Name, and Line Type
Attaching the Sender’s Name to Sent Documents

2.	Sending Faxes
Storing New Destinations
Sending a Fax

Settings Required to Send 
Faxes

To send a fax, you must specify a fax number, unit name, and 
other settings.
The following example describes the procedure for the 
settings below:

	

Fax Number*1

012XXXXXXX

Unit Name*1

sales dept.

Line Type*1

Tone

TX Terminal ID
Print

*1 To specify the telephone line settings, you must log in as an 
administrator. To log in as an administrator, see “Logging In to the 
Machine as an Administrator,” on p. 8.

	

•
•

•
•
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Registering the Fax Number, Unit Name, and 
Line Type

Register the fax number and unit name displayed/printed 
on the destination machine. Set the line type to 'Tone'.

1	 Press (Settings/Registration).

2	 Press [Function Settings].

	

3	 Press [Send].

	

4	 Press [Fax Settings].

	

5	 Press [Set Line].

	

6	 Select the desired line.
The number of lines that appear depends on the optional 
equipment attached to the machine. In this example, 'Line 1' 
is pressed.

	

7	 Press [Register Unit Telephone Number].
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8	 Enter the sender’s fax number using  -  
(numeric keys).
In this example, ‘012XXXXXXX’ is entered.

	

9	 Press [OK].

The fax number is now registered. Next, register the unit name.

10	 Press [Register Unit Name].

	

11	 Enter the new name → press [OK].
In this example, ' sales dept.' is entered.

	

The unit name is now registered. Next, select the line type.

12	 Press [Select Line Type].

	

13	 Press [Tone] → [OK].

	

14	 Press [Close].
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Attaching the Sender's Name to Sent 
Documents

Set the machine so that information for the sender appears 
on sent documents.

1	 Press (Settings/Registration).

2	 Press [Function Settings].

	

3	 Press [Send].

	

4	 Press [Common Settings].

	

5	 Press [TX Terminal ID].

	

6	 Press [Print] → specify the following settings → 
press [OK].
In this example, the following settings are specified:
[Print Position]: [Outside]
[Display Destination Unit Name]: [On]
[Telephone # Mark]: [Fax]

	

7	 Press [Close].
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Sending Faxes
Register the destination in the Address Book to send faxes 
to.

Storing New Destinations

Register the information for the destination in the Address 
Book.
In this example, information for the “central sales dept.” is 
registered in the Address Book.

1	 Press [Fax].

	

2	 Press [Address Book].

	

3	 Press [Other Ops.].

	

4	 Press [Register/Edit].

	

5	 Press [Register New Dest.].

	

6	 Press [Fax].
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7	 Enter the new name → press [Next].
In this example, ‘central sales dept.’ is entered.

	

8	 Enter the destination fax number using  -  
(numeric keys).
In this example, ‘123XXXXXXX’ is entered.

	

9	 Press [OK] → [Close].

10	 Press [OK].

Sending a Fax

Send a fax to the destination registered in “Storing New 
Destinations,” on p. 33.

1	 Place your originals.

2	 Press [Address Book].

	

3	 Select [central sales dept.].

	

4	 Press (Start).
If the [Original Size] screen is displayed, specify the size of the 
original → press [OK].

5	 Press [Start Sending].

	

The fax is sent.
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Sending/Receiving 
Faxes via the Remote 
Fax Server

By using the Remote Fax function on your 
machine, you can send/receive faxes using a 
server machine.
For the purposes of this example, the machine 
(another imageRUNNER ADVANCE series 
machine) that forwards the fax is called the 
"server," and the machine (this machine) from/to 
which the fax is sent is called the "client."
The flow of operations is indicated below.

Sending a Fax via the Remote Fax Server
1.	 Settings Required to Send Faxes via the Remote Fax 

Server
Setting the Server
Setting the Client

2.	 Sending Faxes Using the Remote Fax Server

Receiving a Fax via the Remote Fax Server
1.	 Settings Required to Receive a Fax via the Remote 

Fax Server
Setting the Server
Setting the Client

Settings Required to Send 
Faxes via the Remote Fax 
Server

To send a remote fax, it is necessary to specify the following 
settings.

	

Server Settings 
[Use Remote Fax]
On

Client Settings 
[Remote Fax TX Settings] 
[IP Address]: 192.168.1.24 (IP address of the server)

	

Setting the Server

To use another imageRUNNER ADVANCE series machine 
with a fax board as a server, you must specify the Remote 
Fax TX settings on that machine.
For more information, see the instruction manuals for the 
other imageRUNNER ADVANCE series machine.

●

•
•

●

•
•

●

●

Setting the Client

Set the IP address of the server to send using in the client 
machine.

1	 Press (Settings/Registration).

2	 Press [Function Settings].

	

3	 Press [Send].

	

4	 Press [Fax Settings].
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5	 Press [Remote Fax TX Settings].

	

6	 Press [Remote Fax Server Address] → enter the IP 
address → press [OK].
In this example, ‘192.168.1.24’ is entered for the IP address of 
the server.

	

7	 Press [Close].

The client settings are now specified.

Sending Faxes Using the 
Remote Fax Server

Send faxes using the remote fax server.

1	 Place your originals.

2	 Press [Fax].

	

3	 Enter the destination fax number using  -  
(numeric keys).
In this example, ‘123XXXXXXX’ is entered.

	

You can also specify a destination from the Address Book. For 
more information, see “Sending Faxes,” on p. 33.

4	 Press (Start).
If the [Original Size] screen is displayed, specify the size of the 
original → press [OK].
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5	 Press [Start Sending].

	

The fax is sent.

Settings Required to Receive 
a Fax via the Remote Fax 
Server

To receive a remote fax using the Remote Fax server, you 
must specify settings for the server machine and client 
machine respectively.

	

Server Settings
Forwarding Settings

Client Settings
I-Fax Settings

	

Setting the Server

To receive a remote fax using the Remote Fax server, you 
must specify the settings on the server machine so that the 
received fax data is forwarded to the client machine as an 
I-fax.
To forward fax data, you must register the client machine's 
I-fax address as a forwarding destination on the server 
machine, and specify the forwarding conditions as 
necessary.
For more information on forwarding settings, see e-Manual 
> Settings/Registration.

Setting the Client

To receive a remote fax using the Remote Fax server, you 
must specify the settings on the client machine so that 
the fax data to be received is forwarded from the server 
machine as an I-fax.
For more information on I-fax settings, see e-Manual > 
Settings/Registration.

●

●

Sending Faxes from a 
Computer Using the 
Machine

This example describes the procedure for 
sending a document created on a computer as a 
fax using the machine.
The flow of operations is indicated below.

1.	Settings Required to Send Faxes from a 
Computer

Installing the Fax Driver

2.	Sending Faxes from a Computer

The procedure for displaying the fax driver screen may differ 
depending on the applications you are using. For details, 
see the instruction manuals provided with the application 
software.
The display may differ according to the operating system and 
version of the fax driver.

Settings Required to Send 
Faxes from a Computer

To send a fax from your computer using the machine, you 
must install the fax driver in your computer. After installing 
the fax driver, specify the fax settings.

Installing the Fax Driver

This example describes the procedure for installing the fax 
driver for Windows Vista.

1	 Insert the CD-ROM (the CD-ROM that contains the 
fax driver) into your computer.
In this example, the Windows fax driver is used.

•

•

•
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2	 On the CD-ROM Menu screen, click [Installation].

	

To browse the Fax Driver Installation Guide, click [Display 
Manuals] before you click [Installation].

3	 Follow the instructions on the screen to complete 
the installation.

The fax driver is now installed. 
Next, set the fax environment.

4	 Click  (Start) → [Control Panel] → [Printer] in 
Windows.

	

5	 Right-click the icon of the fax you use → select 
[Properties].

	

6	 Click the [Device Settings] tab → [Get Device 
Status].

	

7	 Click [OK].

The fax environment settings are now specified.

Sending Faxes from a 
Computer

Specify a destination and send a fax. The following example 
describes the procedure for sending a document, created 
using Microsoft Word 2007.

1	 On your computer, open the document to send 
using the fax function.
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2	 Select [Print] from the menu.

	

The [Print] dialog box is displayed.

3	 Select the fax name to use → click [Print]. 

	

The [Fax Sending Settings] dialog box is displayed.

4	 On the [Sending Settings] sheet, enter the 
recipient's name and fax number → click [Add to 
Destination List].

	

5	 Click [OK].

	

The fax is sent.

Printing a Document 
from a Computer

To perform printing, it is necessary to install the 
printer driver in a computer. After installing the 
printer driver, specify the printing preferences.

1.	Settings Required to Print from a Computer
Installing the Printer Driver

2.	Printing from a Computer

Printing methods may differ depending on the applications 
you are using. For details, see the instruction manuals 
provided with the application software.
The display may differ according to the operating system, as 
well as the type and version of the printer driver.

Settings Required to Print 
from a Computer

A printer driver is software required for printing from 
application software.
It is necessary to install a printer driver in a computer to use 
the Print function.

Installing the Printer Driver

This example describes the procedure for installing the 
printer driver for Windows Vista.

1	 Insert the CD-ROM (the CD-ROM that contains the 
printer driver) into your computer.
In this example, the LIPS LX printer driver for Windows is used.

•

•

•
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2	 On the CD-ROM Menu screen, click [Installation].

	

To browse the Printer Driver Installation Guide, click [Display 
Manuals] before you click [Installation].

3	 Follow the instructions on the screen to complete 
the installation.

The printer driver is now installed. 
Next, set the printer environment.

4	 Click  (Start) → [Control Panel] → [Printer] in 
Windows.

	

5	 Right-click the icon of the printer → select 
[Properties].

	

6	 Click the [Device Settings] tab → [Get Device 
Status].

	

7	 Click [OK].

The printer environment settings are now specified.

Printing from a Computer
Print documents created on your computer with the 
machine. The following example describes the procedure 
for printing a document, created using Microsoft Word 2007, 
in color:
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1	 Open the Word document you want to print → 
click [File] → [Print].

	

2	 Select the printer you use for [Name].

	

3	 Click [Properties].

	

4	 Select [Color] for [Color Mode] in the [Quality] 
sheet → click [OK]. 

	

5	 Set the range to print and the number of copies 
→ click [OK].

	

The document is printed.
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Scanning an Original
This example describes the procedure for 
specifying the settings required for scanning, and 
for scanning an original into your computer:
The flow of operations is indicated below.

1.	Settings Required to Perform Scanning
Installing the Scanner Driver
Setting Remote Scanning Online

2.	Scanning an Original

Remote scanning methods may differ depending on the 
applications you are using. For details, see the instruction 
manuals provided with the application software.
The window displayed may differ according to the operating 
system etc.

Settings Required to Perform 
Scanning

To use the Scan function of the machine, it is necessary to 
install the scanner driver (software for specifying scanner 
settings).
The scanner driver can be installed from the same User 
Software CD-ROM used for installing the printer driver.
After that, specify the settings to use the remote scanner on 
the machine.
The flow of operations is indicated below.

	

[Scanner] screen on the machine: 
Online

[ScanGear Tool] on your computer:
The name of your scanner

	

Installing the Scanner Driver

This example describes the procedure for installing the 
scanner driver for Windows Vista.

1	 Insert the CD-ROM in your computer.
Color Network ScanGear is used here.

•
•

•

•

2	 On the CD-ROM Menu screen, click [Installation].

	

To browse the Network ScanGear User’s Guide, click [Display 
Manuals] before you click [Installation].

3	 Follow the instructions on the screen to complete 
the installation.

The scanner driver is now installed. 
Next, enable remote scanning.

Setting Remote Scanning Online

To use the Scan function, it is necessary to enable remote 
scanning on the machine and enable the network scanner 
to use on your computer.

1	 Press [Scanner].

	

2	 Press [Online] on the [Scanner] screen.

	

The scanner is now online.
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Scanned data from your computer can now be received. 
Next, set the scanner to use on your computer.

3	 Click  (Start) → [Programs] → [Color Network 
ScanGear] → [ScanGear Tool].

	

ScanGear Tool is started.

4	 Click [Discover].

	

Scanners on the network are automatically discovered, and 
the searched scanners are displayed in [Select Scanner from 
List].

5	 Select the scanner to use → click [Select].

	

6	 Click [Exit].
ScanGear Tool is closed.

Remote scanning is now enabled.
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Scanning an Original
The following example describes the procedure for placing 
an original on the platen glass of the machine, and using 
remote scanning from your computer to paste the data into 
a Microsoft Office Word 2007 document:

1	 Confirm that remote scanning is online.

2	 Place the original on the platen glass.

	

3	 Start Microsoft Office Word 2007.

4	 Click the [Insert] tab → click [Clip Art].

	

The [Clip Art] pane is displayed.

5	 Click [Organize clips].

	

Microsoft Clip Organizer is started.

6	 Select [File] → [Add Clips to Organizer] → [From 
Scanner or Camera].
The [Insert Picture from Scanner or Camera] dialog box is 
displayed.

7	 From the [Device] drop-down list, select Color 
Network ScanGear → click [Custom Insert].

	

Color Network ScanGear screen is displayed.

8	 Click the [Main] tab → select [Platen] for <Original 
Placement>.

	

9	 Specify the scanning conditions, such as color 
mode and resolution.
Click [Preview] to view a preview.

10	 Click [Scan].
Scanning starts. 
When scanning is complete, the Color Network ScanGear 
screen closes and the scanned image is transferred to [Color 
Network ScanGear Vx.xx] in [My Collections] in Microsoft Clip 
Organizer.

11	 Open a document using Microsoft Word 2007.
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12	 Drag the image scanned using Microsoft Clip 
Organizer, and drop it into the area where you 
want to add the image.

	

The image is added to the area where drag-and-drop was 
performed.

Using an Advanced Box 
on the Network

You can store originals scanned using your 
machine in the Advanced Box of another 
imageRUNNER ADVANCE series machine on the 
network that can be accessed by your machine. 
You can also print the files stored in an Advanced 
Box of another imageRUNNER ADVANCE series 
machine, from your machine.
The following example describes the procedure 
for storing an original scanned using your 
machine as a PDF file in an Advanced Box of 
another imageRUNNER ADVANCE series machine 
that has been made accessible on the network as 
an SMB server.
The flow of operations is indicated below.

1.	Settings Required to Use an Advanced Box 
on the Network

Making an Advanced Box Accessible on the Network 
(Specified by an Administrator for the Machine to 
Open the Advanced Box)
Accessing an Advanced Box on the Network (Specified 
on this Machine)

2.	Storing Data in an Advanced Box on the 
Network

Settings Required to Use 
an Advanced Box on the 
Network

To store scanned originals in an Advanced Box on the 
Network, you must specify the following settings:

	

Another imageRUNNER ADVANCE Series 
Machine

Making the Advanced Box Accessible on the Network as an 
SMB Server

Specifying the SMB Server Settings

This machine

[Network Place Settings]
[Name]: images
[Protocol]: SMB
[Location]: \\192.168.1.23\share

[Protocol for External Reference]
[SMB]: On

[Store Location Display Settings]
[Network]: On

	

•

•

●

•

•

●
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Making an Advanced Box Accessible on the 
Network

On the machine with the Advanced Box to be shared, 
specify the settings to make the Advanced Box accessible 
on the network as an SMB server, and specify the SMB server 
settings. For more information, see the instruction manual 
for the machine with the Advanced Box to be shared.

Accessing an Advanced Box on the Network

Specify the Network Place and Protocol for External 
Reference settings, followed by the Store Location Display 
settings.

1	 Press (Settings/Registration).

2	 Press [Function Settings].

	

3	 Press [Store/Access Files].

	

4	 Press [Network Settings].

	

5	 Press [Network Place Settings].

	

6	 Press [Register].
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7	 Specify the following settings → press [OK].
In this example, the following settings are specified:
[Name]: images
<Protocol>: SMB
[Location]: \\192.168.1.23\share

	

8	 Press [Close].

The Network Place Settings are now set. 
Next, specify the Protocol for External Reference settings.

9	 Press [Protocol for External Reference].

	

10	 Select [On] for <SMB> → press [OK].

	

The Protocol for External Reference settings are now set. 
Next, specify the Store Location Display Settings.

11	 Press (Settings/Registration).

12	 Press [Preferences].

	

13	 Press [Display Settings].

	

14	 Press [Store Location Display Settings].
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15	 Press [On] for <Network> → press [OK].

	

The Store Location Display Settings are now set.

Storing Data in an Advanced 
Box on the Network

Save data scanned on the machine to the Advanced Box of 
another imageRUNNER ADVANCE machine on the network.

1	 Place your original on the machine.

2	 Press [Scan and Store].

	

3	 Press [Network].

	

4	 Select the desired storage location.

	

If an authentication screen is displayed, enter the user name 
and password to log in.

5	 Press [Scan].

	

6	 Specify each of the settings such as [File Format].

	

7	 Press (Start).
If the [Scan Size] screen is displayed, specify the scan size → 
press [OK].
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8	 Press [Start Storing].

	

The scanned document is saved to the Advanced Box of 
another imageRUNNER ADVANCE machine on the network.

9	 Press [Close].
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Installing the System 
Options/MEAP 
Applications

Using the Register/Update Software function, 
you can install the System Options/MEAP 
Applications to the machine. You can use this 
function from both the touch panel display and 
the computer (Remote UI).

Installing by Connecting 
This Machine to an Outside 
Network

You can install the System Options/MEAP Applications by 
accessing the delivery server from this machine.

	

Delivery ServerThis Machine

Access Using the Touch Panel 
Display

License Authentication/MEAP 
Application Delivery

Access Using the Remote UI

Installing by Not Connecting 
This Machine to an Outside 
Network

You can install the System Options/MEAP Applications by 
using the license file/license key that you obtained from the 
License Management System.

	

This Machine

Register the License Key Using the Touch Panel Display
(System Options)

Install the License File Using the Remote UI
(System Options/MEAP Applications*)

1234-5678-1234・・・

* For the MEAP applications, an application file is
   necessary.

Obtain the License 
Key/License File
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License Registration
License registration may be required, depending 
on the System Options/MEAP Applications that 
you are using.

System Options/MEAP 
Applications

You can enhance the functions of the machine by installing 
various system options and MEAP applications.

System Options
The following are the system options you can install on 
this machine.

PS Printer Kit
PCL Printer Kit
Direct Print Kit (for PDF/XPS)
Barcode Printing Kit
Remote Fax Kit
Color Universal Send Kit*1

Universal Send Advanced Feature Set
Universal Send Security Feature Set
Universal Send Digital User Signature Kit
Encrypted Printing Software
2.5inch/80GB HDD*1

Secure Watermark
Data Erase Kit
Web Access Software
ACCESS MANAGEMENT SYSTEM KIT
Remote Operator's Software Kit

*1 If you are using the imageRUNNER ADVANCE C2030H/C2030/
C2025H/C2020H, the Color Universal Send Kit and the 2.5inch/80GB 
HDD are standard-equipped. If you are using the imageRUNNER 
ADVANCE C2020, depending on the region, the Color Universal 
Send Kit and the 2.5inch/80GB HDD are standard-equipped.

MEAP Applications
To enhance the functions of the machine without using 
the above system options, install the MEAP applications.

If you want to perform MEAP applications management, such 
as the ones shown below, use SMS (Service Management 
Service). (See e-Manual > MEAP.)

Checking the MEAP applications installed on this machine
Checking the amount of memory the MEAP applications 
are using
Adding a license to an installed MEAP application

●

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

●

•
•

•

Installing the System 
Options/MEAP Applications

The procedures to install the system options or MEAP 
applications on the machine differ, depending on whether 
the machine is connected or not to an outside network. 
Select the procedure that matches your conditions using 
the references below.

For instructions on connecting the machine to an outside 
network, see “Connecting the Machine to a Network,” on p. 9.

Installing by Connecting this Machine to an 
Outside Network

Install using one of the following procedures.

To check that the transmission with the delivery server is 
properly operating, if necessary, perform a transmission test 
before installation. (See “Testing Communication Using the 
Touch Panel Display,” on p. 61, and “Testing Communication 
Using the Remote UI,” on p. 62.)

	

Using the touch panel display to install
See “Using the Touch Panel Display to Install (Delivery),” 
on p. 54.

Using the Remote UI to install
See “Using the Remote UI to Install (Delivery),” on p. 56.
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Installing by Not Connecting this Machine to 
an Outside Network

Installing System Options
Install using one of the following procedures.

If you want to install multiple system options, we recommend 
using the Remote UI.

Using the touch panel display to install
1.	 Obtain the license key from the License 

Management System 
See “Obtaining the License Key/License File,” on p. 
57.

2.	 Register the license key using the touch panel 
display 
See “Installing the System Options Using the Touch 
Panel Display,” on p. 57.

Using the Remote UI to install
1.	 Obtain the license file from the License 

Management System 
See “Obtaining the License Key/License File,” on p. 
57.

2.	 Install the license file using the Remote UI 
See “Installing the System Options Using the 
Remote UI (Manual),” on p. 58.

Installing MEAP Applications
Use the following procedure to install.

Using the Remote UI to install
1.	 Obtain the license file from the License 

Management System 
See “Obtaining the License Key/License File,” on p. 
57.

2.	 Install the license file and application file using the 
Remote UI 
See “Installing the MEAP Applications Using the 
Remote UI (Manual),” on p. 58.

3.	 Start the MEAP applications from SMS 
See “Starting the MEAP Applications,” on p. 59.

	

●

●

Installing by Connecting 
This Machine to an 
Outside Network

If the machine is connected to an outside 
network, you can install the system options and 
MEAP applications by linking with the delivery 
server.

Make sure that the license access number that is included with 
the package is available.

Using the Touch Panel 
Display to Install (Delivery)

You can install the system options or MEAP applications to 
the machine using the touch panel display.

To perform the procedures described in this section, you must 
log in to the machine as an administrator. (See “Logging In 
from the Touch Panel Display,” on p. 8.)

The maximum number of MEAP applications that can be 
installed is 19.
The maximum amount of memory allocated to install MEAP 
applications is 1GB. (If you are using the imageRUNNER 
ADVANCE C2020, this value may vary depending on the 
region.)
There may be other system requirements for installation, 
depending on the MEAP applications. For instructions 
on settings, see the manual provided with the MEAP 
application.

1	 Press (Settings/Registration) → [Management 
Settings] → [License/Other] → [Register/Update 
Software].

2	 Press [Install Applications/Options].

	

•

•

•
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3	 Press [License Access Number].

	

4	 Enter the license access number four digits at a 
time.

	

Enter four digits of the license access number → press [OK]. 
Repeat this step four times to enter a total of 16 digits for the 
license access number.

5	 Press [Start].

	

6	 Select the system options and MEAP applications 
→ press [Install].

	

[Do Not Start]: Press to only install the MEAP application and 
not start the application.

If [Do Not Start] is selected when installing MEAP applications, 
you must start the application before using the MEAP 
application. (See “Starting the MEAP Applications,” on p. 59.)

You can select multiple system options and MEAP applications, 
but you cannot select the same product with different version 
at the same time.

If the agreement screen is displayed, read the agreement. If 
you abide with the agreement, press [Accept].

7	 Check the Installation Result screen.

	

When the installation of the system options is completed, the 
message <Enabled After Restart> appears on the Installation 
Result screen. Restart the machine to enable the function.

You can download the manuals for the installed system 
options/MEAP applications from your computer by accessing 
the URL for the manual download site displayed on the 
Installation Result screen. (See “Downloading the Manuals and 
Related Software,” on p. 60.)
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Using the Remote UI to 
Install (Delivery)

You can install the system options or MEAP applications to 
the machine using the Remote UI.

To perform the procedures described in this section, you must 
log in to the machine as an administrator. (See “Logging In 
Using the Remote UI,” on p. 8.) 

1	 From the top page of the Remote UI, click 
[Settings/Registration] → [License/Others] → 
[Register/Update Software].

	

2	 Click [Delivered Installation].

	

3	 Enter the license access number → click [Next].

	

Once the license access number is confirmed after contacting 
the delivery server, information for the system options/MEAP 
applications you can install are displayed.

If the license access number is incorrect, an error page is 
displayed.

4	 Select the system options and MEAP applications 
→ click [Start Installation].

	

Status after Installation: 
Start: Starts the installed MEAP applications.
Stop: Stops the installed MEAP applications.

If [Stop] is selected when installing MEAP applications, you 
must start the application before using the MEAP application. 
(See “Starting the MEAP Applications,” on p. 59.)

If the agreement screen is displayed, read the agreement. If 
you abide with the agreement, click [Accept].

5	 Check the Installation Result screen.

	

When the installation of the system options is completed, the 
message <Restart the device.> appears. Restart the machine 
to enable the function.
To return to the Delivered Installation screen, click [To 
Delivered Installation].

You can download the manual for the installed system 
options/MEAP applications by accessing the URL for the 
manual download site displayed on the Installation Result 
screen. (See “Downloading the Manuals and Related Software,” 
on p. 60.)
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Installing by Not 
Connecting This Machine 
to an Outside Network

This section describes how to install the 
system options and MEAP applications without 
connecting the machine to an outside network.

Obtaining the License Key/
License File

Obtain the license key or license file.

License key: 
Obtain the license key when installing the system 
options using the touch panel display.

License file: 
Obtain the license file when installing the system 
options/MEAP applications using the Remote UI.

Make sure that the license access number that is included with 
the package is available.
If the license access number is not printed on the package of 
the MEAP application you are using, the license file is issued 
by the distributor of the MEAP application. You do not need to 
obtain the license key/license file explained in this section. For 
more information, see the manual for each MEAP application.

1	 Check the management number you need to 
obtain the license key or the license file.
To obtain the license key or the license file, the following 
management number is required.

License Access Number: Check the license access number 
certificate.

Device Serial Number: Check and note the serial number 
which is displayed at the bottom left of the screen when 
you press [Counter Check] on the machine.

2	 Access http://www.canon.com/lms/license/.

3	 Follow the instructions on the screen and obtain 
the license key/license file.
If the license key is obtained, see “Installing the System 
Options Using the Touch Panel Display,” on p. 57.
If the license file is obtained, see “Installing the System Options 
Using the Remote UI (Manual),” on p. 58 or “Installing the MEAP 
Applications Using the Remote UI (Manual),” on p. 58.

●

●

•

•

•

•

Installing the System 
Options Using the Touch 
Panel Display

You can install the system options to the machine by 
registering the license key using the touch panel display.

To perform the procedures described in this section, you must 
log in to the machine as an administrator. (See “Logging In 
from the Touch Panel Display,” on p. 8.)

1	 Press (Settings/Registration) → [Management 
Settings] → [License/Other] → [Register License].

2	 Enter the license key using  -  (numeric keys).

	

Details of each item are shown below.
  : Press to move the cursor.

[Backspace]: Press when you entered a wrong number. The 
number in front of the cursor is deleted and you can reenter 
the correct number. 
If the message <The value for the license key is not correct. 
Check the license key.> is displayed, press [OK] → enter the 
correct license key. 
If the message <The feature required for installation is not 
present.> is displayed, you cannot register the license key. 
Press [OK] → cancel the registration.

3	 Press [Start] → [OK].
The registered functions can be used only after you restart the 
machine.
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Installing the System 
Options Using the Remote UI 
(Manual)

You can install the system options to the machine using the 
Remote UI.

To perform the procedures described in this section, you 
must log in to the machine as an administrator. (See “Settings 
Required to Use the Remote UI,” on p. 15.)

1	 From the top page of the Remote UI, click 
[Settings/Registration] → [License/Others] → 
[Register/Update Software].

	

2	 Click [Manual Installation].

	

3	 Click [Browse] → select the license file to install → 
click [Next].

	

File extensions:
License File: A file with the 'lic' extension.

You do not have to use Application File Path.
You can also specify the file path by entering it directly.

4	 Check the contents that will be installed on the 
confirmation screen → click [Install].

•
•

Installing the MEAP 
Applications Using the 
Remote UI (Manual)

You can install the MEAP applications to the machine using 
the Remote UI.

To perform the procedures described in this section, you 
must log in to the machine as an administrator. (See “Settings 
Required to Use the Remote UI,” on p. 15.)

The maximum number of MEAP applications that can be 
installed is 19.
The maximum amount of memory allocated to install MEAP 
applications is 1GB. (If you are using the imageRUNNER 
ADVANCE C2020, this value may vary depending on the 
region.)
There may be other system requirements for installation, 
depending on the MEAP applications. For instructions on 
settings, see the manual provided with the MEAP application.

1	 From the top page of the Remote UI, click 
[Settings/Registration] → [License/Others] → 
[Register/Update Software].

	

2	 Click [Manual Installation].

	

•

•

•
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3	 Click [Browse] → select the license file and the 
application file to install → click [Next].

	

File extensions:
License File: A file with the 'lic' extension.
Application File: A file with the 'jar' extension.

You cannot install license files only.
When installing the MEAP application, make sure you specify 
the license file. You cannot install the MEAP application 
without specifying the license file.

You can also specify the file path by entering it directly.

4	 Confirm the information displayed on the install 
confirmation page → click [Yes].

	

Depending on the MEAP application, a software license 
agreement screen may be displayed. Confirm the information 
displayed on the screen → click [OK].
If you are installing a new MEAP application, the following 
information is displayed on the screen.

Application Information

License Information
The following information is displayed when you overwrite a 
MEAP application.

Current Application Information

Application Information after Overwrite
Installation will start after the message <Installing... Please 
wait.> is displayed again. After the installation, click [To Manual 
Installation] to display the Manual Installation screen.

To use the installed MEAP application, you must start the 
MEAP application. (See “Starting the MEAP Applications,” on 
p. 59.)

•
•

•

•

•

•

Starting the MEAP 
Applications

This section describes how to start the installed MEAP 
application from the SMS screen.

For more information on SMS, see e-Manual > MEAP.

1	 From the top page of the SMS, click [MEAP 
Application Management].

	

2	 Click [Start] for the application to start.
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Downloading the 
Manuals and Related 
Software

You can download the manuals for the installed 
system options/MEAP applications and their 
related software from the following URL.
http://canon.com/fau/downloads

Make sure that the license access number that is included with 
the package is available.
If you cannot find a manual to download, see the function 
descriptions in the e-Manual included with this machine.
If you installed from the Remote UI, you can jump to the above 
URL from the link displayed on the Installation Result screen. If 
you do so, the license access number is entered automatically.

1	 Start the Web browser on your computer.

2	 Enter the URL in [Address].

3	 After entering the license access number, follow 
the instructions on the screen to download the 
manuals and related software.
If software is downloaded, refer to the manual of that software 
to install.

•

•

•

Managing by Using the 
Touch Panel Display

You can display the installation logs and test 
communication using the touch panel display.

To perform the procedures described in this section, you must 
log in to the machine as an administrator. (See “Logging In 
from the Touch Panel Display,” on p. 8.)

Displaying the Installation 
Log Using the Touch Panel 
Display

You can check the installation logs of the system options 
and MEAP applications.

1	 Press (Settings/Registration) → [Management 
Settings] → [License/Other] → [Register/Update 
Software].

2	 Press [Software Management Settings].

	

3	 Press [Select Log Display].
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4	 Press [Display Update Logs].

	

The installation logs of the system options and MEAP 
applications are displayed.

	

Testing Communication 
Using the Touch Panel 
Display

You can check whether the machine can properly 
communicate with the delivery server.

1	 Press (Settings/Registration) → [Management 
Settings] → [License/Other] → [Register/Update 
Software].

2	 Press [Software Management Settings].

	

3	 Press [Test Communication].

	

4	 Press [Yes].

	

Contents for the test are downloaded from the delivery server.
When the communication test is completed, the Test 
Communication screen is displayed.

	

If 'Failed' is displayed on the Test Communication screen, 
check that the network cable is connected and that the 
network settings are correct. If the problem is not resolved, 
contact your local authorized Canon dealer.
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Managing by Using the 
Remote UI

You can display the installation logs and test 
communication using the Remote UI.

To perform the procedures described in this section, you 
must log in to the machine as an administrator. (See “Settings 
Required to Use the Remote UI,” on p. 15.)

Displaying the Installation 
Log Using the Remote UI

You can check the installation logs of the system options 
and MEAP applications.

1	 From the top page of the Remote UI, click 
[Settings/Registration] → [License/Others] → 
[Register/Update Software].

	

2	 Click [Display Logs /Communication Test].

	

3	 From the Log View drop-down list, select [Update 
Logs] → click [Switch].

	

The installation logs of the system options and MEAP 
applications are displayed.

Testing Communication 
Using the Remote UI

You can check whether the machine can properly 
communicate with the delivery server.

1	 From the top page of the Remote UI, click 
[Settings/Registration] → [License/Others] → 
[Register/Update Software].
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2	 Click [Display Logs /Communication Test] → 
[Communication Test].

	

When the confirmation dialog is displayed, click [Yes].
Contents for the test are downloaded from the delivery server.
When the communication test is completed, the 
communication test result screen is displayed.

	

If 'Failed' is displayed on the communication test result screen, 
check that the network cable is connected and that the 
network settings are correct. If the problem is not resolved, 
contact your local authorized Canon dealer.

Updating the Firmware
This section describes how to update firmware.

Updating Firmware
Using the Register/Update Software function, you can 
update the firmware of the machine to the most recent 
version.

For information on the log in service, see e-Manual > MEAP. If 
the authentication function is not set, the Log In screen is not 
displayed.
For information on necessary system environment and 
preparation to start the Remote UI, see e-Manual > Remote UI.
Multiple users cannot use the Register/Update Software 
function at the same time.
If another user is logged in to SMS (Service Management 
Service), you cannot use the Register/Update Software 
function from the Remote UI.
If the following procedure is performed, you cannot use the 
Register/Update Software function from the Remote UI for a 
specified time:

When Remote Login Service of the SMS is set and the Web 
browser was closed without pressing [Portal] or [Log Out]
When Remote Login Service of the SMS is not set and the 
Web browser was closed without pressing [Portal]
When the Web browser was closed without pressing [Log 
Out from SMS], [To Remote UI], or [Log out] of the SMS

For more information on SMS, see e-Manual > MEAP.

You can update the firmware using the data that is 
distributed separately from the machine.

	

Obtaining the 
Firmware

Updating the 
Firmware

Registering the 
Firmware from the 
Remote UI

This Machine

Updating Using the Remote 
UI (Manual)

You can update the firmware from the Remote UI that is 
connected to the machine.

To perform the procedures described in this section, you must 
log in to the machine as an administrator. (See “Logging In 
Using the Remote UI,” on p. 8.)

To perform the procedures described in this section, the data 
of the firmware that is distributed separately from the machine 
is necessary.

•

•

•

•

•

•

•

•

•
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1	 From the top page of the Remote UI, click 
[Settings/Registration] → [License/Others] → 
[Register/Update Software].

	

2	 Click [Manual Update].

	

3	 Click [Browse] → select the firmware to update → 
click [Next].

	

4	 Check the contents that will be updated on the 
confirmation screen → click [Yes].

	

The new firmware is now applied to the machine. 
When the message <The firmware is updated. Restart 
the device.> appears, restart the machine.
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